
Agilent Technologies
N5106A PXB 
Baseband Generator 
and Channel Emulator

Notice: This document contains
references to Agilent. Please note that 
Agilent’s Test and Measurement business 
has become Keysight Technologies. For 
more information, go to 

www.keysight.com. 
Quick Start Guide
Agilent Technologies

http://www.keysight.com
http://www.keysight.com


PXB Quick Start Guide

Notices
© Keysight Technologies, Inc. 2008-2015 
No part of this manual may be reproduced 
in any form or by any means (including 
electronic storage and retrieval or transla-
tion into a foreign language) without prior 
agreement and written consent from Agi-
lent Technologies, Inc. as governed by 
United States and international copyright 
laws.

Manual Part Number
N5105-90004

Edition
April 2016

Printed in USA

Keysight Technologies, Inc.
3501 Stevens Creek Blvd. 
Santa Clara, CA 95052 USA

Warranty

The material contained in this doc-
ument is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, 
to the maximum extent permitted 
by applicable law, Agilent disclaims 
all warranties, either express or 
implied, with regard to this manual 
and any information contained 
herein, including but not limited to 
the implied warranties of mer-
chantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connec-
tion with the furnishing, use, or 
performance of this document or of 
any information contained herein. 
Should Agilent and the user have a 
separate written agreement with 
warranty terms covering the mate-
rial in this document that conflict 
with these terms, the warranty 
terms in the separate agreement 
shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights.  Soft-
ware and technical data rights granted to 
the federal government include only those 
rights customarily provided to end user 
customers.  Agilent provides this custom-
ary commercial license in Software and 
technical data pursuant to FAR 12.211 
(Technical Data) and 12.212 (Computer 
Software) and, for the Department of 
Defense, DFARS 252.227-7015 (Techni-
cal Data - Commercial Items) and DFARS 
227.7202-3 (Rights in Commercial Com-

puter Software or Computer Software 
Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in damage to the product or loss 
of important data. Do not proceed 
beyond a CAUTION notice until 
the indicated conditions are fully 
understood and met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, 
or the like that, if not correctly 
performed or adhered to, could 
result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the 
indicated conditions are fully 
understood and met.
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Installation and Setup
Unpacking 
Unpacking
1. Inspect the shipping container for damage.

Signs of damage can include a dented or torn shipping container or cushioning material that indicates signs of
unusual stress or compacting.

2. Carefully remove the contents from the shipping container and verify that your order is complete.

NOTE Depending on the number of hardware installed options the instrument may weigh up to 33 kg (70 lbs.). The 
PXB should be lifted by at least two people. If two people are not available, use a mechanical lift to lift the 
PXB. The PXB should be transported using a rolling cart.

The following items are included with the PXB:

• N5106A PXB Baseband Generator and Channel Emulator Quick Start Guide

• N5106A PXB Baseband Generator and Channel Emulator Firmware DVD

• Three–prong C19 AC power cord (specific to geographic location)

• SMB (female) to BNC (male) 50Ω cable, 1.0m (39.37 in.)

3. Verify that the hardware options you ordered are included with the shipment by checking the serial number label on
the rear of the PXB and the packing literature included with the shipment.

4. If a pre-installed software license is part of the instrument order, verify its installation using the directions outlined
in “Verifying Pre-Installed Software License” on page 6.
2 PXB Quick Start Guide



 Installation and Setup
Ordering Accessories
Ordering Accessories
You can purchase accessories or documentation at: http://www.agilent.com/find/pxb.

If you do not have access to the Internet, contact your Agilent Technologies representative.

Description Part Number Option

N5106A PXB Baseband Generator and Channel Emulator Data Sheeta

a. All documentation is available on the internet at http://www.agilent.com/find/pxb. 
Always refer to this web site for the most recent and up-to-date documentation. 

5989–8971EN

Cable, SMB (female) to BNC (male), 50Ω 1.0m (39.37 in.)
(external reference/trigger cable)

8121–1789

N5106A 720

Cable, Digital Bus (approximately 1 meter, 2 per IO card) N5105-60028

N5106A PXB Baseband Generator and Channel Emulator Quick Start Guidea N5105–90004

USB Accessory Kit 

Includes the following USB enabled devices:

• Keyboard
• Optical Mouse
• Disk Drive (DVD–ROM/CD–RW)

N5106A 181

Rack Mount Flange and Front Handle Kit N5106A 1CP

Rack Mount Slide Kit N5106A 1CR

Approved Power Cords (IEC-60320-C19)

• United Kingdom
• Australia and New Zealand
• Continental Europe
• United States and Canada
• Switzerland
• Denmark
• India
• Japan - 100V
• Israel
• Argentina
• Chile
• China
• South Africa
• Thailand
• Brazil
• Taiwan

8121-8620
8121-8619
8121-1222
8121-1713
8121-1765
8121-1882
8121-0710
8121-1763
8121-0161
8121-1857
8121-1084
8121-1766
8121-0710
8121-1764
8121-1787
8121-1853
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Installation and Setup
Options 
Options
The following tables list the options available for the PXB:

• “Baseband Hardware Options”

• “IO Hardware Options”

• “Built-in Firmware Options”

• “Hardware and Firmware Bundled Options”

• “Software Bundle Options”

• “Upgrade Options”

Baseband Hardware Options

Option Number Description

N5106A-611 one DSP block on one baseband generator card

N5106A-612 two DSP blocks on one baseband generator card

N5106A-613 three DSP blocks on two baseband generator cards

N5106A-614 four DSP blocks on two baseband generator cards

N5106A-615 five DSP blocks on three baseband generator cards

N5106A-616 six DSP blocks on three baseband generator cards

N5106A-617 seven DSP blocks on four baseband generator cards

N5106A-618 eight DSP blocks on four baseband generator cards

N5106A-619 nine DSP blocks on five baseband generator cards

N5106A-620 ten DSP blocks on five baseband generator cards

N5106A-621 eleven DSP blocks on six baseband generator cards

N5106A-622 twelve DSP blocks on six baseband generator cards

IO Hardware Options

Option Number Description

N5106A-632 One IO card that provides two IO ports. Each IO port has both digital IO and analog I/Q.

N5106A-634 Two IO cards that provide four IO ports. Each IO port has both digital IO and analog I/Q.
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 Installation and Setup
Options
Built-in Firmware Options

Option Number Description

N5106A-EFP Baseband generation

N5106A-JFP Calibrated AWGN

N5106A-QFP Fading with SISO channel models

N5106A-RFP Mobile WiMAX MIMO channel models

N5106A-TFP LTE MIMO channel models

Hardware and Firmware Bundled Options

Option Number Description

N5106A-2B2 2x2 MIMO baseband generation and channel emulation bundle

This bundle consists of the N5106A with options 616, 634, EFP, JFP, and QFP. 

Software Bundle Options

Option Number Description

N5106A-LTE LTE MIMO software application bundle

This bundle adds the N5106A-TFP LTE MIMO channel models and Signal Studio model N7624B 3GP LTE 
with options 6FP, GFP, and RFP. 

N5106A-WMX Mobile WiMAX MIMO software application bundle

This bundle adds the N5106A-RFP WiMAX MIMO channel models and Signal Studio model N7615B 
802.16 WiMAX with options 6FP, EFP, QFP, and RFP. 

Upgrade Options

Option Number Description

N5106AK-031 Enables one DSP block on one baseband generator card.

N5106AK-032 Adds one baseband generator card.

N5106AK-034 Adds one IO card that provides two IO ports. Each IO port has both digital IO and analog I/Q. 
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Verifying Pre-Installed Software License 
Verifying Pre-Installed Software License
If you purchased the PXB where the order included the pre-installation of a fixed perpetual Signal Studio license 
(N76xx), verify the license installation using the following key path:

Tools > Keysight License Manager

This launches the Keysight License Manager, from which to view installed licenses.

The ordered Signal Studio software is also pre-installed with the license. 

If the software license was ordered with the instrument for pre-installation and it does not show in the instrument, please 
contact Keysight Technologies:

www.keysight.com/find/contactus
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 Installation and Setup
Meeting Environmental and Electrical Requirements
Meeting Environmental and Electrical Requirements

WARNING If this product is not used as specified, the protection provided by the equipment could be impaired. 
This product must be used in a normal condition (in which all means for protection are intact) only.

Environmental conditions (operating)
• for indoor use (unless otherwise specified)
• altitudes < 10,000 feet (3,000 meters)
• 10 to 40 °C temperature (unless otherwise specified)
• maximum relative humidity 80% for temperatures up to 31 °C, decreasing linearly to 50% relative humidity at 40 °C

CAUTION This product is designed for use in Installation Category II and Pollution Degree 2 per IEC 61010 Second 
Edition and 664 respectively.

Ventilation Requirements

Ventilation holes are located on the side panels of the PXB. To ensure proper air flow through the PXB, do not allow 
these holes to be obstructed.

CAUTION When installing the PXB in a cabinet, the convection into and out of the instrument must not be restricted. 
The ambient temperature (outside of the cabinet) must be less than the maximum operating temperature 
of the instrument by 4 °C for every 100 watts dissipated in the cabinet. If the total power dissipated in the 
cabinet is greater than 800 watts, then forced convection must be used.

The PXB has intake fans are on the left side of the instrument and exhaust fans are on the right side. If 
multiple instruments are placed side-to-side, the hot exhaust air from one instrument becomes the input 
air for the instrument next to it which may cause it to overheat. 

Line Setting Requirements

CAUTION The PXB has autoranging line voltage input. Ensure that the supply voltage is within the specified range.

Voltage:  100/120 VAC nominal

220/240 VAC nominal

Frequency:  50/60 Hz nominal

Power:  < 875 W typical

1075 W maximum

Connecting the AC Power Cord

WARNING This is a Safety Class 1 Product (provided with a protective earthing ground incorporated in the 
power cord). The mains plug shall only be inserted in a socket outlet provided with a protective 
earth contact. Any interruption of the protective conductor inside or outside of the product is likely 
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Installation and Setup
Installing the PXB in an Equipment Rack 
to make the product dangerous. Intentional interruption is prohibited.

The front panel Power hardkey is only a standby switch; it is not a line switch. 

Install the instrument so that the detachable power cord is readily identifiable and is easily reached by the operator. The 
detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply 
before other parts of the instrument. The front panel switch is only a standby switch and is not a LINE switch. 
Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the 
operator) may be used as a disconnecting device.

CAUTION The Mains wiring and connectors shall be compatible with the connector used in the premise electrical 
system. Failure to ensure adequate earth grounding by not using the correct components may cause 
serious injury and instrument damage. Always use the three–prong AC power cord supplied with the 
PXB.

CAUTION Before switching on this instrument, make sure

• The correct rating service breaker

• The supply voltage is in the specified range

Prior to connecting the AC power cord follow these steps:

1. Ensure that the supply voltage is in the specified range. 

2. Ensure that the power cord is not damaged.

3. Install the PXB so that one of the following is readily identifiable and easily reached by the operator:

• AC power cord

• alternative switch

• circuit breaker

4. Insert the mains plug into a socket outlet provided with a protective earth grounding.

Installing the PXB in an Equipment Rack
To prepare an equipment rack for mounting a PXB, you must install rails in the rack to support the weight of the 
instrument. You may use either Option 1CP or Option 1CR to secure the PXB in the rack. Follow the instructions 
provided with each kit.

Position the instrument so that the disconnecting device is within easy reach.

Connecting a USB Mouse
A mouse can be used for fine control of the PXB graphical user interface. The mouse may be connected to any one of the 
eight Type A USB connectors of the PXB (the four front panel or the four rear panel (USB Slave) connectors).

NOTE If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not 
boot up, try removing all USB devices until the boot up process has completed.
8 PXB Quick Start Guide



 Installation and Setup
Connecting an External USB Keyboard
Connecting an External USB Keyboard
A keyboard can be used as an input to the PXB. The keyboard may be connected to any one of the eight Type A USB 
connectors of the PXB (the four front panel or the four rear panel (USB Slave) connectors).

NOTE If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not 
boot up, try removing all USB devices until the boot up process has completed. 

Connecting an External VGA Monitor
The monitor connector on the rear panel of the PXB allows you to connect an external VGA monitor.

Connecting External Instruments to the PXB
The PXB connects to a variety of external instruments for testing. Included with the PXB is a cable for locking the 
frequency references between the PXB and the external instruments that are connected. This section contains 
single-in-single-out (SISO) front and rear panel connection setups for the PXB and the external instruments. For 
multiple-in-multiple-out (MIMO) setups, additional external equipment is used following the same basic interconnection 
scheme shown in this section. For additional information on MIMO setups, refer to Example Configuration Setups 
tutorial in the online documentation.

NOTE The block diagrams in the PXB user interface show which IO ports to use for each specific configuration.

External Instrument Firmware
The PXB requires that the external instruments have the following firmware installed:

• E4438C ESG signal generator:  C.05.23 or later

• N5182A MXG signal generator: A.01.44 or later

• N5172B EXG/N5182B MXG signal generators: B.01.20 or later

• N9020A MXA signal analyzer: A.01.64 or later

Refer to the instrument’s Users Guide for information on downloading the latest firmware releases.
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Installation and Setup
Connecting External Instruments to the PXB 
External Instrument Connection Diagrams

The following setup diagrams assume that the PXB is the controller and uses GPIB as the interface between instruments. 
Optionally the PXB can control the instruments through the LAN. To use LAN connections, ignore the shown GPIB 
cable connections and connect each instrument to the LAN. 

PXB to ESG or MXG Signal Generator Setup

Figure 1-1 PXB to ESG or MXG Signal Generator

MXA to PXB to ESG or MXG Signal Generator Setup

Figure 1-2 MXA to PXB to ESG or MXG Signal Generator
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 Installation and Setup
Connecting External Instruments to the PXB
PXB to Digital Signal Interface Module Setup

Figure 1-3  PXB to Digital Signal Interface Module

PXB to ESG or MXG Signal Generator Analog I/Q Setup

Figure 1-4 PXB to ESG or MXG Signal Generator Analog I/Q 
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Installation and Setup
Powering On the PXB the First Time 
Powering On the PXB the First Time

CAUTION During boot up, do not press keys on the front panel, rotate the RPG knob, or connect a USB device. 
Doing so may lead to a front panel lockup state. Wait until the PXB firmware is running and all activity 
has stopped for at least one minute.

Initializing the System

CAUTION The PXB must remain on through the system initialization operation.

The system initialization may take up to 20 minutes to complete and will perform three system reboots. If a power 
interruption occurs during this process, select the appropriate action from the following list:

• If the process has not performed the first reboot, restart the process after the power has been restored.

• If the process has gone beyond the first reboot, perform the recovery steps, refer to the“Agilent Technologies 
Recovery System” on page 51.

1. To start the initialization process, press the PXB Power hardkey located on the front panel.

The Power LED changes from yellow to green.

2. Verify that the version of Windows is highlighted and press the PXB front panel Enter hardkey.

3. If a Windows license agreement is displayed, read the terms and accept the agreement, and click Next

For more information about the License Agreement for Windows, see the questions and answers about the End-User 
License Agreement topic in the Microsoft Windows Help and Support documentation.

4. Follow the ensuing prompts.
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 Installation and Setup
Powering On the PXB the First Time
Power-up Self Test

During the PXB interface launch, the PXB performs a self test, which includes a configuration check. If an error occurs 
during the self test, the PXB displays an error message. If this occurs, refer to the N5106A PXB error messages 
document (N5105-90012) or contact Agilent Technologies.

Anti-virus Software and Firewalls

The PXB is Windows-based and may be subject to virus exposure when connecting to the network/internet. We have 
anti-virus requirements to ensure that your PXB arrives to you virus free. To ensure a continued virus free product status, 
we recommend you follow these steps:

• When connecting to the network/internet, ensure it is a trusted site.

• Ensure all removable or writable media are virus free before use.

• Install anti-virus protection on your PXB

No anti-virus software is shipped with the instrument. It is recommended that you install anti-virus software if your 
instrument will be connected to the LAN. Check with your IT department for their recommendations. 

The instrument is shipped with the Windows firewall enabled. Do not modify the default network settings as this may 
cause improper operation. However, you will have to temporarily disable the firewall if you install licenses from a 
remote computer.

Power Option Settings

The PXB is sent from the factory with the following power option settings:

• The monitor is set to shut off after one hour of inactivity.

• The hard disk drive (HDD) is set to shut off after three minutes of inactivity.

• The System standby is set for Never.

The PXB does not support the Microsoft Windows Standby or Hibernate modes.

CAUTION To prolong HDD life, Agilent recommends that you leave the power option settings at their default 
values.
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Shut Down Mode 
Shut Down Mode
In the Shut Down mode, the current instrument state is not automatically saved before the PXB is powered off. The 
Power LED will change from green to yellow when the power is off. When the PXB is again powered on, a full system 
boot up is performed followed by automatically launching the PXB user interface. 

NOTE This section describes Shut Down mode for Windows XP. For Windows 7, refer to the Microsoft Windows 
Help and Support documentation.

CAUTION If you cannot operate the mouse or keypad, shut down the PXB by pressing and holding the Power 
hardkey for at least four seconds. Repeated shut downs in this manner may damage the hard drive and 
should be avoided.

To Shut Down Using a Mouse
1. Move the mouse cursor to the bottom edge of the display to activate the Windows task bar.

2. From the Windows task bar, click Start > Shut Down to display the Shut Down Windows dialog box.

3. Click the drop-down arrow located beneath the What do you want the computer to do? prompt.

4. Select Shut down > OK to perform the action.

To Shut Down Using the Power Hardkey

CAUTION Do not press and hold down the Power hardkey as this performs an improper shutdown.

1. Firmly press the front panel Power hardkey and release it. The instrument immediately begins the shutdown 
process.

Unplugging the PXB

Remove the power cord from the PXB only when the Power LED is yellow (in Shut Down mode). The Power LED will 
remain yellow for several seconds after the power cord has been removed.

CAUTION Removing the power cord while the Power LED is green may cause damage to the HDD and corrupt the 
operating system. It may also damage the PXB’s FPGA code.
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Connecting the PXB to LAN
Connecting the PXB to LAN 
Microsoft Windows supports fixed Internet Protocol (IP) addressing and Dynamic Host Configuration Protocol (DHCP). 
The PXB Windows factory default setting is DHCP. This system queries the LAN server and assigns a dynamic IP 
address to the device on a network. Like the USB devices, the LAN cable has the capability of "hot" connects and 
disconnects. In addition, there is a visual indicator in the Windows task bar area that indicates LAN connection status 
and a network wizard that provides assistance with network and internet connections. For more information, refer to the 
Microsoft Windows Help and Support documentation.

NOTE To add your instrument to a domain or to set up the networking configuration, contact your IT department. 
This setup is custom for each company.

Licensing the PXB
Additional firmware licenses can be ordered after your initial purchase of the PXB. Once you purchase a license you will 
receive an Entitlement Certificate. In order to receive the license you must redeem this certificate at the Agilent License 
Redemption website:

http://www.agilent.com/find/softwarelicense

You will promptly receive an e-mail with the license file attached. There are two methods to install the license. 

• You can install the license on the PXB using a USB storage device. 

• You can run the Agilent License Manager software from an external PC connected to the PXB through a LAN 
connection.

NOTE If you are unable to connect to the PXB or if you receive an error message when trying to connect, temporarily 
disable the Windows Firewall. From the Windows task bar, click Start > Control Panel > Windows Firewall 
> Off.

For more information on licensing, refer to the “Online Documentation” on page 17.
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Proper Use and Cleaning 
Proper Use and Cleaning

WARNING The PXB cover protects against physical contact with internal assemblies that contain hazardous 
voltages, but does not protect internal assemblies against contact with liquids. Ensure that liquids 
are positioned away from the PXB. Personal injury may result if the PXB is not used as specified. 
Unspecified use impairs the protection provided by the equipment. 

WARNING No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical 
shock, do not remove covers.

Cleaning Suggestions

Touch Screen Panel

CAUTION Do not use products that contain Ammonia, Phosphates, or Ethylene Glycol. Their use can result in the 
optical impairment of the touch screen panel or damage the functionality. Check the product content label 
carefully.

NOTE Glass or plastic cleaning products that contain one to three percent isopropyl alcohol by volume are within the 
acceptable limits for cleaning the resistive touch screen panel.

• Use a soft lint-free cloth.

• The cloth may be used dry or lightly dampened with a mild cleaner. 

• Do not use a cleaner that contains more than 10% isopropyl alcohol.

• Never apply the cleaner directly to the touch screen surface. 

• Wipe the surface gently. If there is a directional surface texture, wipe in the same direction as the texture. 

• Avoid contact with the edges of the film, glass, and the flex tail of the touch screen surface. 

• Use a cleaner that has a pH of 7.0 (neutral).

• Do not use chemicals such as paint thinner, acetone, toluene, xylene, or kerosene.

• The following are suitable cleaning products for the touch screen surface: 

Klear Screen™

Glass Plus® Glass and Surface Cleaner 
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Online Documentation
Front and Rear Panel Connectors

WARNING Cleaning the connectors with isopropyl alcohol should be done with the instrument’s power cord 
removed and in a well ventilated room. Allow all residual isopropyl alcohol moisture to evaporate 
and the fumes to dissipate prior to energizing the instrument.

• To ensure good connections, regularly clean the instrument’s front and rear panel connectors with isopropyl alcohol.

Instrument Cover

WARNING To prevent electrical shock, disconnect the N5106A power cord from the mains supply before 
cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do 
not attempt to clean internally.

• To prevent dust build-up that could potentially obstruct ventilation, periodically clean the instrument’s cover with a 
dry cloth or a cloth lightly dampened with water. 

• Do not clean any internal surface of the instrument.

Online Documentation
Use the online documentation to reference programming and user information. Help information is available in English.

You can access the online documentation by pressing the Help hardkey on the front panel or selecting the Help menu in 
the PXB firmware. There is no hardcopy of the online documentation available.

All documentation is available on the internet at http://www.agilent.com/find/pxb. 
Always refer to this web site for the most recent and up-to-date documentation. 
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Online Documentation 
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2 Front and Rear Panel Features

• Front Panel Hardkeys on page 20

• Touch Screen Display on page 22

• USB Connectors on page 23

• System Clock Rear Panel Connectors on page 24

• CPU Host Controller Rear Panel Connectors on page 26

• I/O Board Connectors on page 27
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Front and Rear Panel Features 
Front Panel 
Front Panel

Front Panel Hardkeys

The front panel hardkeys enable the user to define, monitor, and manage the input and output characteristics of the PXB 
user interface.

Figure 2-1 Front Panel Hardkeys

17. RPG (Rotary Pulse 
Generator) Knob 

18. Power 15. Tab (Left) 

16. Tab (Right) 

1. Ctrl (Control) 

3. Main 

2. Alt (Alternate) 
11. Keyboard 

10. Touch On/Off 

14. System 

13. Help 

19. USB Connectors 6. Numeric Keypad 

12. Preset 4. Cancel 
5. Delete 

7. Enter 

8. (Up/Down 
Arrow Keys) 

9. (Left/Right 
Arrow Keys) 
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 Front and Rear Panel Features
Front Panel
1. Ctrl (Control)

Functions as a modifier key. When the Ctrl hardkey is pressed in conjunction with another key, it performs a special 
operation.

2. Alt (Alternate)

Functions as a modifier key. When the Alt hardkey is pressed in conjunction with another key, it performs a special 
operation.

3. Main

Displays the active window of the PXB user interface. If the user interface is hidden behind the window of another 
application, pressing Main brings it to the front of the display.

4. Cancel (Esc)

Functions like the Escape hardkey. In the local mode, the Cancel (Esc) hardkey cancels tasks. In the remote mode, 
Cancel (Esc) functions as the Local hardkey. It deactivates remote operation and returns the instrument to front panel 
control.

5. Delete

Discards the character at the cursor's position, moving any following characters to the left to fill the empty spaces.

6. Numeric Keypad

The numeric keypad is comprised of the following: the numbers 0 through 9, a decimal point, a minus sign, space, and 
backspace keys.

7. Enter

Enables you to enter the values that you select for the measurement settings. Pressing Enter after entering data enables 
you to terminate editing. Pressing the Enter hardkey also activates selected (highlighted) menu items and keys.

8. (Up/Down Arrow Keys)

Enables you to move the cursor vertically through a table to select items for editing on the system's display.

9. (Left/Right Arrow Keys)

Enables you to move the cursor horizontally through a table to select items for editing on the system's display.
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Front and Rear Panel Features 
Front Panel 
10. Touch On/Off

The touch screen default is on. The selection off or on is persistent through power cycles. When on, the touch screen 
works in the PXB and Windows with PXB minimized. When you press the Touch On/Off hardkey, the PXB user 
interface displays a message in the status bar indicating the status of the touch screen: 

• Information, Touch screen is off

• Information, Touch screen is on

11. Keyboard

Launches the on-screen keyboard from the front panel hardkey.

12. Preset

Resets the PXB user interface to a factory–defined state. The user interface automatically starts up in this 
factory–defined, default mode where one block is selected from the Generate category in the Configuration Browser, and 
its corresponding configuration is displayed on the Block Diagram tab.

13. Help

Opens the Agilent PXB online documentation help system.

14. System

Provides a shortcut to the PXB user interface System menu where you can view product information, set system clock 
and trigger settings, perform calibrations and self tests, and configure GPIB addresses.

15. Tab (Left)

Functions as the Shift + Tab combination of hardkeys. This hardkey enables you to navigate in the opposite direction of 
the Right Tab hardkey in order to edit or activate items in the loaded configuration.

16. Tab (Right)

Enables you to navigate through and edit or activate items in the loaded configuration. For example, in the Parameter 
View, pressing the Tab hardkey moves you to and selects the next item for the currently selected parameter. When you 
move to the parameter settings cell, the Tab hardkey automatically selects (highlights) the entire cell, allowing you to 
edit that parameter value.

17. RPG (Rotary Pulse Generator) Knob

Functions like a mouse wheel. Rotating the RPG knob increases or decreases a numeric value, moves the highlight to the 
next digit, character, or item in a list, or fast scrolls on large documents.

18. Power 

Turns the PXB power on and off.

Touch Screen Display

The touch screen display eliminates the need for the external keyboard and mouse as the primary method of interacting 
with the PXB user interface. The touch screen can be used to perform all the same functions as the mouse by the use of 
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your finger to select items on the screen.

1. Open the PXB user interface by clicking the PXB Baseband Generator and Channel Emulator icon on the 
desktop display.

2. To enable the touch screen display, press the Touch On/Off hardkey on the front panel of the PXB. 

The touch screen mode indicator is displayed on the lower status bar of the PXB user interface.

If your touch screen display seems inaccurate or unresponsive when using it, perform the touch screen display 
calibration. The procedure for performing the Touch Screen Calibration, is located in the Basic Instrument Procedures 
section of the online documentation.

USB Connectors

19. USB Connectors

The PXB has eight USB Type A 2.0 ports for connecting devices; four on the front panel and four on the rear panel 
(USB Slave). There are also two USB Type B ports on the rear panel which are used for connecting to the host ports of 
other computers through a USB interface cable. When the PXB is set up in this primary/secondary configuration, SCPI 
commands can be sent from the host computer to control the PXB. The main advantages of USB devices are the fast data 
transfer speeds. In addition, most devices can be "hot" connected and disconnected to your instrument at anytime.

The first time you plug a device into a USB port, Windows will report it is identifying the hardware, searching for the 
correct driver, and installing the driver (if it was found). If the USB device is moved to a different USB port, Windows 
will repeat the hardware and driver identification process.

NOTE If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not 

boot up, try removing all USB devices until the boot up process has completed.
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Figure 2-2 Rear Panel Connectors 

System Clock Rear Panel Connectors

1. EXT I/O CLK IN

Not active – reserved for future use

2. EXT SYNC

Not active – reserved for future use

3. EXT TRIG IN

External input signal used to trigger an event

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: +3.3 V 

Damage Levels < 0 V and > +3.3 V 

12. USB SLAVE 9. AUX I/O 

7. I/O CLK OUT 

8. TRIGGER OUT 

5. 10 MHz OUT 

4. EXT REF IN 

10. AC Power Receptacle 

11. MONITOR 

13. USB MASTER 

14. LAN 

1. EXT I/O CLK 
IN 

2. EXT SYNC 

3. EXT TRIG IN 

15. GPIB 

19. PCIe x4 TO DOWNSTREAM 

17. eSATA 

18. PCIe x4 FROM UPSTREAM 

16. INTERCONNECT 1/2 20. USB MASTER 

6. 100 MHz SYS CLK
OUT 
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4. EXT REF IN

Input for an external frequency reference signal

5. 10 MHz OUT

10 MHz reference output used to lock the frequency reference of other test equipment to the PXB

6. 100 MHz SYS CLK OUT

100 MHz system clock output

7. I/O CLK OUT

Not active – reserved for future use

8. TRIGGER OUT

Not active – reserved for future use

9. AUX I/O

This port provides connectivity to external devices for auxiliary signaling information. The AUX I/O connector mates to 
a 36-pin 3M® male connector, part number 10136-3000 (wire mount plug). Earlier PXB models use a 20-pin connector 
of the same style. See the PXB online documentation for a description of AUX I/O uses, signaling specifications, 
general pin assignments, and global AUX I/O settings. See the Signal Studio application's help for application-specific 
settings and pin assignments.

10. AC Power Receptacle

The AC power cord receptacle accepts a three–pronged AC power cord supplied with the PXB. For details on line 
setting requirements and the power cord, see Line Setting Requirements on page 7.

Connector male SMB Impedance nominally 50 Ω
Signal Power range:

Frequency range:

Lock range:

0 to +10 dBm

1 to 100 MHz

1 MHz

Damage Levels < 0 V and > +3.3 V 

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: +900 mV p-p

Damage Levels < 0 V and > +3.3 V 

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: +2.0 V p-p

Damage Levels < 0 V and > +3.3 V 
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11. MONITOR

Allows connection of an external VGA monitor

12. USB SLAVE

Standard USB 2.0 ports, Type A connect to external peripherals such as a mouse, keyboard, printer, DVD drive, or hard 
drive

13. USB MASTER

USB 2.0 port, Type B USB TMC (test and measurement class) connect to an external PC controller to control the PXB 
and for data transfers over a 480 Mbps link

14. LAN

Network interface used to control the PXB remotely

15. GPIB

A General Purpose Interface Bus (GPIB, IEEE 488.2 GPIB) connection that can be used for remote operation

16. INTERCONNECT 1/2

Not active – reserved for future use

17. eSATA

This port provides connectivity to external eSATA Hard Disk Drive (HDD) storage devices to increase system file 
storage capacity. The eSATA HDD operate at 150 Mbytes per second (MB/s) or 300 MB/s eSATA rates. This is the 
physical layer speed for the serial data across the cable. The actual average transfer rate to the host memory or the HDD 
is lower.

CAUTION A device connected to this port is not “hot” swappable. The PXB should be powered off before adding or 
removing the HDD. The device should be connected and powered on before the instrument and the PXB 
should be powered off before the device is powered down or disconnected.

A device plugged in or powered on while the Windows Operating System (OS) is running will not be 
recognized and will require restarting the Windows OS. Removing an active device will cause Windows 
OS errors.

18. PCIe x4 FROM UPSTREAM

Not active – reserved for future use

19. PCIe x4 TO DOWNSTREAM

Not active – reserved for future use

20. USB MASTER

Not active – reserved for future use
26 PXB Quick Start Guide



 Front and Rear Panel Features
Rear Panel
I/O Board Connectors

Figure 2-3 I/O Board Connectors

21. CLOCK IN

Not active – reserved for future use

22. TRG IN

Not active – reserved for future use

23. MKR OUT

Marker outputs for each I/O board port numbered 1, 3, and 4 (marker 2 is reserved for internal use)

24. CLOCK OUT

Not active – reserved for future use

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: +3.3 V 

Damage Levels < 0 V and > +3.3 V 

23. MKR OUT 25. DIGITAL BUS I/O 22. TRG IN 21. CLOCK IN 24. CLOCK OUT 

26. CHANNEL 1 
ANALOG I/Q 
OUTPUTS 

27. CHANNEL 2 
ANALOG I/Q 
OUTPUTS 
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25. DIGITAL BUS I/O

Digital bus connectors (channel 1 and 2) enable operation with other test equipment, such as the MXA signal analyzer, 
MXG signal generator, ESG signal generator, and digital signal interface module, via the digital bus cable (Agilent part 
number N5101-60019).

26. CHANNEL 1 ANALOG I/Q OUTPUTS

Analog output, in–phase (I+ and Q+) component and 180-degrees out-of-phase (I− and Q−) components of I/Q baseband 
signal from the channel 1 side of the internal baseband card

27. CHANNEL 2 ANALOG I/Q OUTPUTS

Analog output, in–phase (I+ and Q+) component and 180-degrees out-of-phase (I− and Q−) components of I/Q baseband 
signal from the channel 1 side of the internal baseband card

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: 2.0 Vp-p 

Damage Levels < –15 V and > +15 V

Connector male SMB Impedance nominally 50 Ω
Signal Voltage level: 2.0 Vp-p 

Damage Levels < –15 V and > +15 V
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3 Using the PXB

• Keys to Success with the PXB on page 30

• Administering User Accounts on page 34

• To Create a New Account on page 35

• To Change the User Account Properties on page 36

• Hard Drive Partitioning and Use on page 38

• Licensed Firmware on page 38

• Running Self Test on page 39

• PXB System Information on page 43

• Remote Desktop: Using the PXB Remotely on page 44

• Agilent Technologies Recovery System on page 51

• Returning the PXB to Agilent Technologies on page 52

• Removing Sensitive Data on page 52
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Keys to Success with the PXB
In an effort to make your experience with the PXB as successful and effortless as possible, a variety of tips are listed 
below. A quick review of these tips prior to using the PXB will help with your success.

External Instrument Firmware
— Make sure the external instruments have the correct firmware revisions installed (see the online documentation 

for details and recommended options):

• E4438C ESG signal generators (firmware version C.05.23 or later)

• N5182A MXG signal generators (firmware version A.01.44 or later, A.01.60 recommended) 

• N5172B EXG/N5182B MXG signal generators (firmware version B.01.20 or later)

• N9020A MXA signal analyzers (firmware version A.01.64 or later)

Power
— Make sure you have the correct C19 AC power cord. PXB power cords are unique on the PXB end.

Cables
— Many of the connectors on the PXB I/O cards are SMB. You'll need one to four SMB to BNC cables (Agilent 

part number 8121-1789) or adapters depending on your setup (differential analog I/Q output setups and markers 
require more SMB to BNC cables or adapters).

— Make sure all the cables are connected to the correct ports for your setup.

10 MHz Reference
— You must have the 10 MHz reference connected between external instruments and the PXB. Otherwise, you risk 

data underflow/overflow, which yields sub-optimal results. 

— Make sure the PXB reference is correctly set to internal or external for your setup.

Digital I/O Bus
— Make sure the digital bus cables (Agilent part number N5105-60019, 2 cables per IO card) are correctly 

connected between the external instruments and the PXB. 

— Verify that the digital bus cable connectors are securely locked on both sides and at both ends.
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LAN and GPIB
— Make sure the LAN or GPIB connection to the external instruments is working. It is important to note that the 

GPIB port must be either an input or an output. Therefore, you cannot control the PXB through a GPIB input, 
and then concurrently use the PXB to control an MXA or an MXG through the GPIB output. There are multiple 
ways that allow the PXB to be a listener and a talker concurrently:

• Use LAN for all instruments, so that this problem never arises.

• Use the PXB as the controller, so that the GPIB port is only an output. If you use the PXB as a GPIB 
controller, be sure to enable the interface in Agilent IO libraries. The PXB defaults to a slave instrument.

• Use mixed modes: LAN to PXB, then GPIB from PXB to external instruments.

• Use GPIB as the input to PXB, then USB-to-GPIB converters to connect PXB to external instruments.

PXB Firmware
— There are two PXB executable icons on the desktop - one indicates simulation mode and the other uses real 

hardware.

• Use the mode that exercises the hardware (does not have "Simulation Mode" in its name).

• When the PXB powers up, it auto-starts PXB firmware. 

PXB Licensing
— To install licenses on the PXB, run the Agilent License Manager (ALM) from within the PXB.

• If you have a USB memory device with a PXB license file saved on it, the PXB will not automatically 
install the license.

PXB Unexpected Errors
— If you encounter an unexpected error, do as instructed by the firmware.

1. Save the N5106A and InternalN5106A event logs:

a. Select Start > Control Panel > Administrative Tools > Event Viewer.

b. Open the N5106A and InternalN5106A event logs.

2. Report the problem to your Agilent representative with as much detail as possible when describing what was 
being done when the problem occurred.
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External Instruments
— The external instruments must be in a known state when the PXB is controlling them.

• Before starting, preset the external instruments.

• Make the external instrument settings from the PXB user interface, not from the external instrument front 
panel.

MXA as an RF Input Device
— You must set the attenuator to maximize dynamic range. 

— Do not let the input power to multiple MXAs be widely different. A 20 dB difference is OK; 
a 50 dB difference is not because both are using the same settings and they do not have that much dynamic range 
in the digitizer.

MXG/ESG as an RF Output Device
— You must run a user IQ calibration on the MXG or ESG to minimize LO feedthrough. 

— It is possible for the RMS of the signal to get so low due to the backoff required for Peak to Average Ratio of 
fading and noise, that LO feedthrough becomes a significant contributor to EVM and output power.

— A good I/Q calibration is critical to making accurate measurements.

MXG/ESG ALC Settings
— In general, the PXB works best with the ALC turned off in the signal generators. 

— Having the ALC turned on only works when channel summing, noise, and fading are turned off.

— If you must turn the ALC on, you will have to route the markers manually in the signal generator user interface.

Power Calibration
— As a default, power calibration is set to Auto which means the power calibration is performed every time the 

waveform is played. 

— Power calibration operates on the setup as currently configured. Specifically, if you are using fading or AWGN 
noise, make sure they are on and have their proper settings prior to initiating the power calibration.

— Any time you do anything that might increase or decrease the RMS value of the signal (at any point in the signal 
path) by more than 10 dB, re-run the power calibration. 
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MIMO Configurations
— Set all the output signal generators to the same power, the power of the highest signal in the group.

— The PXB provides power balancing between antennas so that the output power will be correct when measured 
with a power meter.

Play
— When you think the PXB is playing, check for the DIGBUS annunciator on the front panel of the ESG or MXG. 

If the annunciator is not displayed, one of the following is probably the issue:

• The digital bus cable is not present or is not connected correctly.

• The waveform is not actually playing.

• The waveform output is directed at the wrong I/O port.

• The incorrect firmware revision is installed in the signal generator.

Fader
— Check that the carrier frequency in the Fader Master Setup panel matches the carrier frequency of the RF 

source when using the fader. 

• These parameters are not automatically coupled and will cause Doppler errors if they are different. 

Touch Screen
— If you want to use the touch screen, there is a Windows keypad for entering units. To open the keypad: 

• Select On-Screen Keyboard from the Tools menu.

• With the PXB application as the active window, press the Keyboard hardkey on the front panel.
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Administering User Accounts 

NOTE This section describes administering user accounts for Windows XP. For Windows 7, refer to the Microsoft 
Windows Help and Support documentation.

The administration of user accounts is accessed through the User Accounts menu from the Windows task bar by clicking 
Start > Control Panel > User Accounts.

• Existing User Accounts on page 34 

• To Create a New Account on page 35 

• To Change the User Account Properties on page 36

Figure 3-1 User Accounts Main Menu

A person may be designated as the administrator and can configure the PXB to allow others to use the instrument with 
reduced permissions. These users can have use of the PXB but will not have the ability to perform all of the 
administrative functions.

Existing User Accounts

The following user accounts already exist on the PXB.

Default User Account
The PXB is shipped from the factory with the following default user name and password.

• User name: Instrument

• Password: measure4u (all lower case)
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Agilent Technologies recommends that you change the user name and password. Although allowed by Windows, do 
not delete this account. The default user account has the same privileges as the administrator account.

Administrator Account
The PXB is shipped from the factory with an Administrator account. 

• User name: Administrator

• Password: agilent4u (all lower case)

Agilent Technologies recommends that you change the password, but not the user name. This account is created by 
Windows and cannot be deleted.

Guest Account
This account allows any user name to be entered without a password and gain limited access to the PXB files. This 
account is created by Windows and cannot be deleted. It can be renamed. This account is turned off when the instrument 
is shipped. To turn on this account, refer To Change the User Account Properties on page 36.

To Create a New Account

You can set up the PXB users by name and grant various levels of access. This is particularly important when the PXB is 
remotely controlled or accessed over a LAN.

NOTE You can create as many user accounts as you like. The user name is not case sensitive. The password is 
case sensitive.

CAUTION Although allowed by Microsoft Windows, Agilent Technologies strongly recommends that all 
Administrator accounts be password protected. Internet viruses look for and exploit this condition.

1. Click Create New Account.

Figure 3-2  Name the new account

2. In the User Accounts dialog box, enter a user name for this account and select Next.

For this procedure, John Smith was entered as an example user name.
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Figure 3-3  Pick an account type

3. Select the account type for this user account.

• Computer Administrator 

• Limited

4. Click Create Account.

To Change the User Account Properties

A user account can be removed, the password changed, or a new level of access can be granted. The Guest account may 
be turned on by clicking the Guest icon > Turn On the Guest Account.

1. Click Change an account

Figure 3-4  Pick an account to change

2. Click the account name, John Smith.

This opens the Account Name dialog box (see Figure 3-5.)
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Figure 3-5 Account Name

3. Select the change you wish for this account.

• Change the name

• Change the password

• Change the picture

• Change the account type

• Delete the account 

Each selection opens a dialog box and requires you to make your selection for the intended change of this account.

4. Click OK to confirm.
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Hard Drive Partitioning and Use
The hard drive is divided into three partitions: C:, D:, and E:

• The C: partition contains the Windows operating system (OS) and the PXB firmware installed by Agilent 
Technologies. It is an open system wherein the installation of additional software is permitted. The installation and 
use of other software is not warranted, and may interfere with the operation of the PXB firmware. If a PXB repair is 
ever needed, the Agilent version (OS and PXB firmware) of the C: partition is the only part that is restored by the 
Agilent Recovery System Procedure on page 51. You will need to reload any other software that you have added in 
the PXB.

• The D: partition is reserved for data storage. The User Accounts that are configured by Agilent Technologies have 
their My Documents folder mapped to the D: partition. This is for the convenience of backing up the user-created 
waveforms or user-defined configuration on the D: partition or an external device. This allows you to restore the 
data if you ever need to replace the hard drive.

• The E: partition is reserved for Agilent Technologies’ use and contains the self test data and the log files of the last 
self test performed. Do not change or overwrite the files on this drive. This could cause your instrument to not meet 
specifications or, in the worst case, stop functioning correctly. Do not use this drive for data storage. 

Licensed Firmware
The PXB has licensed firmware options installed that can be purchased at any time without requiring a download. For 
more information on licensing these measurement applications, refer to the Online Documentation on page 17.
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Running Self Test
The PXB provides a method of performance verification that allows you to select any number of self tests. These self 
tests check the power supply voltages and clock signals on the baseband generator boards, the I/O boards, and the 
midplane board. Depending on the number of boards installed, the duration of the self tests may range from a few 
minutes up to 20 minutes. After the self tests are complete, it will report if the tests passed or failed along with the related 
measured values and self test limits.

1. In the PXB user interface, select Self Test from the System menu to open the Self Test dialog box.

Figure 3-6 Opening Self Test

2. Select the self tests that you want to run.

Figure 3-7 Select a Group of Self Tests
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You may select:

• Individual self tests by selecting the check box for each test you want to run

• Groups of self tests (for example, all clock tests) by selecting the check box at the top of each group

• All self tests by selecting the Select All button near the bottom of the dialog box

If you want to remove selected tests from the list of self tests that will be run, you may remove:

• Individual self tests by clearing the check box for the test

• All self tests by selecting the Deselect All button near the bottom of the dialog box

3. Select Run to start the self tests.

A message is displayed indicating any unsaved configuration setups will be lost during the self test. If you want to 
save your configuration setup information, select the Cancel button and save the configuration using the File > Save 
As before running the self tests.

Figure 3-8 Warning Message
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4. Select OK to start running the self tests.

Figure 3-9  Running Self Test

During the self tests, a status box is displayed showing the progress of the tests.

5. After completion, the self tests results are shown. The Test State column displays the status of each test, Passed or 
Failed.

Figure 3-10 Self Test Pass/Fail Test State
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6. To view the self test details (for example, measured values, upper/lower self test limits, etc.), select a test then select 
the Show Details button.

Figure 3-11View Test Details

7. To save the test results as a text file (*.txt), click the Save All Results button and select a location where you want 
the file to be saved. The default location is the Self Test folder on the E: drive partition of the PXB.

8. To print the test results, open the saved file in the Notepad application (or another text editor) and print using the 
print function in the application.

9. To exit the Self Test dialog box, click the Close button.
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Locating the Computer Name 

To connect a remote computer to the PXB, you need to know its “computer name” (machine name). You can view the 
computer name and other networking information by either of the following two methods.

Windows XP

1. Minimize the PXB user interface.

2. On the Windows task bar, click Start > right-click My Computer > Open.

3. Click View system information.

4. In the System Properties dialog box, click the Computer Name tab.

5. The name to the right of Full computer name is the computer name.

Windows 7

1. Minimize the PXB user interface.

2. On the Windows task bar, click Start > right-click Computer > Open.

3. Click System properties.

4. The Computer Name is shown in the System properties control panel.

PXB User Interface
1. Restore the PXB user interface by clicking the PXB Baseband Generator and Channel Emulator icon on the 

Windows task bar.

2. In the PXB user interface, click System > Product Information.

3. In the System Information tab, the name to the right of Machine Name is the computer name.

Figure 3-12 Product Information Window 

4. To exit the Product Information window, click Block Diagram.

Checking the IP Address

You can view the IP address and other networking information from the PXB user interface.
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1. Select Product Information from the System menu (shown in Figure 3-6 on page 39) to view the System 
Information tab.

The System Information tab lists the IP address and other system information. See Figure 3-12.

2. To exit the Product Information window, select Block Diagram.

Remote Desktop: Using the PXB Remotely
The Windows XP Remote Desktop Connection can be used for remote control of the PXB. It offers fully interactive 
control that is almost identical to the front-panel control of the PXB. 

NOTE The Remote Desktop functionality is a Microsoft Windows XP and Windows 7 feature. The following 
information provides guidelines for using this feature with the PXB. For more information, refer to the 
Microsoft Windows Help and Support documentation. Over time Windows functionality may change. Refer to 
the Microsoft website.

Overview of Remote Desktop Operation

The remote desktop functionality of the PXB allows you to control and interact with the PXB from a remote computer.

When you have configured the PXB for remote connectivity and configured a separate computer to act as a remote 
desktop host, you can control the PXB and view the its display on the computer.

This section provides instructions of how to set up the PXB for remote connectivity and how to set up a computer 
running any 32-bit version of Microsoft Windows.

Setting Up Remote Desktop Operation

Setting Up the PXB - Windows XP

Before the PXB can be controlled with a Remote Desktop Connection, it must be set up to allow the connection.

NOTE To perform this operation, you must have Administrator level access to the PXB.

1. On the Windows task bar, click Start > Control Panel.

2. Select Performance and Maintenance > System.

3. In the System Properties dialog box, click the Remote tab.

4. In the Remote Desktop panel, click the Allow users to connect remotely to this computer checkbox. 

5. To add users, click Select Remote Users... and follow the on-screen instructions and then select OK. 

Setting Up the PXB - Windows 7

Before the PXB can be controlled with a Remote Desktop Connection, it must be set up to allow the connection.

NOTE To perform this operation, you must have Administrator level access to the PXB.

1. On the Windows task bar, click Start > Control Panel.
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2. Select the System control panel.

3. In the System control panel, click Remote settings.

4. The System Properties dialog box will open with the Remote tab selected.

5. Make sure Allow connections from computers running any version of Remote Desktop is selected. 

6. To add users, click Select Users... and follow the on-screen instructions and then select OK. 

Setting Up the Remote Computer

This setup procedure depends on whether the remote computer is running Windows XP/Windows 7 or another version of 
Microsoft Windows.

• If the remote computer is running Windows XP or Windows 7, the Remote Desktop Connection Client software is 
included. No additional setup is required.

• If the remote computer is running any 32-bit version of Windows (e.g. Windows 95, 98, ME, NT4.0, or 2000) that 
supports remote desktop connection, you will need to download and run the Remote Desktop Connection Client 
software from the Windows website. 

NOTE Agilent Technologies offers no warranty regarding the operation of such software. 
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Running a Remote Desktop Session

NOTE This section describes Running a Remote Desktop Session for Windows XP. For Windows 7, refer to the 
Microsoft Windows Help and Support documentation.

Initializing a Remote Desktop Session

To initialize a remote desktop session you need to know the computer name and the IP address of the PXB. For this 
information, refer to Locating the Computer Name and Checking the IP Address on page 43.

After setting up both the PXB and the remote computer for Remote Desktop Connectivity, as described in Setting Up 
Remote Desktop Operation, you are ready to start a Remote Desktop session.

1. Make sure the PXB has been powered up and the PXB user interface has loaded.

2. From the remote computer, click Start > All Programs > Accessories > Remote Desktop Connection.

3. In the Remote Desktop Connection dialog box, enter the IP address of the PXB. 

Figure 3-13 Remote Desktop Connection

4. Click Connect.

5. Log in by entering the PXB’s user name and password. The default user name is instrument and the default 
password is measure4u (all lower case), but note that these parameters may have been changed by other users.

Figure 3-14 Log On to Windows display
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NOTE Only the current User or an Administrator can remotely log into the instrument. To see who the current user of 
the PXB is, press the Ctrl + Esc hardkeys on the instrument until you can view the current user name on the 
Start menu. If no one is currently logged into the instrument, any valid instrument user can remotely log in.

6. The PXB display appears on the screen of the remote computer. Most of the PXB functions can be accessed using 
the remote computer’s keyboard and mouse. In addition, there are some keyboard shortcuts that can be used to 
access some PXB front panel functions. See Keyboard Shortcuts for Remote Desktop Operation on page 50.

Setting Remote Desktop Options

These options are accessed in the Remote Desktop Connection dialog box as in Figure 3-13 by clicking Options.

Figure 3-15  Remote Desktop Connection Options – General

The Options menu has several tabs. Generally, the default settings are correct. However, there are some restrictions on 
particular settings under certain tabs, as listed below.

• Under the General tab, ensure that the Computer name, User name, and Domain name are correctly set. 

• You may choose to enter the password and save it for future sessions, by checking the Save my password check 
box.
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Figure 3-16  Remote Desktop Connection – Display Options

Under the Display tab the following options are available:

• In the Remote desktop size panel, you may select the size of the window in which the PXB display will appear. Do 
not select any size smaller than 1024 x 768 pixels. Selecting a remote desktop size smaller than 1024 x 768 results in 
the PXB display not being fully visible. In such circumstances, scroll bars do not appear, so portions of the display 
are not accessible.

• In the Colors panel, you may select any setting that use 15 bits or more. Selecting a color setting that uses less than 
15 bits results in dithering and incorrect color rendition of the remote desktop window.
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Figure 3-17  Remote Desktop Connection Experience Options

Under the Experience tab you have the following options:

• In the Performance panel, you can optimize the performance of the remote desktop session by choosing the 
appropriate connection format from the drop–down list box.

• You may also select any of the check boxes which you consider appropriate.

Ending a Remote Desktop Session

Disconnect the remote computer from the PXB to end the remote desktop session.

1. Select the IP Address Remote Desktop icon in the upper left corner of the Window’s title bar then select Close. 

A dialog box appears indicating Disconnect Terminal Services Session. 

2. Click OK to confirm disconnect.
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Keyboard Shortcuts for Remote Desktop Operation

NOTE The effect of pressing Ctrl + Alt + Delete on the keyboard of the remote computer always applies to the 
remote computer, and not to the PXB. Generally, the effect of this hardkey combination is to display the 
Windows Task Manager. Therefore, pressing this hardkey combination on the remote computer does not 
reboot the PXB.

When the PXB is in Remote Desktop mode, the following 
remote keyboard keys can be used to mimic the operation of the 
PXB front panel hardkeys.

When using the PXB in Remote Desktop mode, the 
following remote keyboard keys can be used to mimic the 
operation of the PXB’s user interface File menu/toolbar.

Front Panel Key Name
Remote Keyboard 
Equivalent

User Interface Command 
Name

Remote Keyboard 
Equivalent

– (Minus Sign) – (Minus Sign) New Configuration Ctrl + N

. (Decimal Point) . (Decimal Point) Recall Ctrl + O

← → 
(Left/Right Arrow Keys)

← → 
(Left/Right Arrow Keys)

Save Ctrl + S

↑ ↓ 
(Up/Down Arrow Keys)

↑ ↓ 
(Up/Down Arrow Keys)

Print Ctrl + P

0–9 (Number Keys) 0–9 (Number Keys) Copy Ctrl + C

Alt (Alternate) Alt (Alternate) Paste Ctrl + V

Bk Sp (Backspace) Backspace Undo Ctrl + V

Cancel (Esc) Esc Opens Keyboard Help F1

Ctrl (Control) Ctrl Opens File Menu F10

Delete Delete

Enter Enter

Help F1

Keyboard Ctrl + Alt + K

Main Ctrl + Alt + M

Preset Ctrl + Alt + P

RPG (Rotary Pulse Generator) 
Knob

none

Space Space Bar

System Ctrl + Shift + Y

Tab (Left) Shift + Tab

Tab (Right) Tab

Touch On/Off Ctrl + Alt + T
50 PXB Quick Start Guide



Using the PXB
Agilent Technologies Recovery System
Agilent Technologies Recovery System
The Agilent Technologies Recovery System is used to recover from a serious malfunction caused by corrupted or 
missing files on the PXB's primary C: drive partition.

CAUTION The operating system recovery will overwrite the C: drive partition, restoring the instrument's operating 
system back to its original factory condition. After performing the recovery, any option upgrades, 
additional software, or user accounts added since purchase of the PXB are lost and need to be reinstalled.

Save any files, programs, or user data that you want to keep on the D: drive partition before running the operating system 
recovery. My Documents is mapped to the D: drive partition, which is designated for user data and will not be affected 
by the recovery process. Although the E: drive partition will not be affected by the recovery process either, it is not 
recommended that you store your data on this partition because it is designated for factory instrument calibration data.

Agilent Recovery System Procedure
1. Click Start > Shut Down > Restart > OK.

2. In the screen after the Agilent logo, when Please select the operating system to start: displays, press the Down 
arrow hardkey on the PXB front panel to highlight the Agilent Recovery System and then press Enter.

Figure 3-21  Agilent Recovery System

3. Follow the instructions on the screen to complete the Agilent Recovery System procedure.

Refer to Initializing the System on page 12 for information on starting the PXB for the first time.
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Returning the PXB to Agilent Technologies
If you experience a problem with your PXB that you cannot correct and need to return the PXB to Agilent Technologies 
for repair, follow these steps to ensure your security and facilitate the repair of your instrument. 

1. Gather as much information as possible about the PXB’s problem.

2. Remove sensitive proprietary information from the PXB (if required). Refer to Removing Sensitive Data.

3. Contact Agilent Technologies using the phone number that is specific to your geographic location. These phone 
numbers are listed on the internet at http://www.agilent.com/find/assist. If you do not have access to the Internet, 
contact your Agilent Technologies representative. 

After you provide the information about the PXB and its condition, you will receive information about where to ship 
your PXB for repair.

4. Ship the PXB in the original factory packaging materials, if available, or use similar packaging to properly protect 
the instrument.

Removing Sensitive Data
If your PXB has secure data on the hard drive and you need to move your PXB from your secure environment, you will 
need to remove the hard drive from the PXB. 

For complete information, refer to the Agilent N5106A PXB Baseband Generator and Channel Emulator Security 
Features document (Agilent part number N5105-90014). All documentation is available on the internet at 
http://www.agilent.com/find/pxb. Always refer to this web site for the most recent and up-to-date documentation. 
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4 Using Microsoft Windows

NOTE This section describes using Microsoft Windows XP. For Windows 7, refer to the Microsoft Windows Help 
and Support documentation.

• Microsoft Windows Considerations on page 54

• On-Screen Keyboard on page 55

• User Installation of Software on page 55

• Capturing/Printing Displays and Windows on page 56

• Windows Security on page 56

• System Backup on page 56
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Microsoft Windows Considerations
Agilent Technologies has modified and optimized the Microsoft Windows operating system to work with the PXB 
firmware and to control the hardware that performs the PXB functions. Heed the following instructions and avoid 
repairs:
• Do not modify or reconfigure the operating system.

• Do not install a standard version of the Windows operating system on the PXB.

• Do not change advanced performance settings or group policies.

• Do not add, change, or delete any Hard Disk Drive (HDD) partitions on the PXB.

• Do not delete the Agilent Technologies user account.

• Do not modify any of the Agilent Technologies Windows Registry entries.

Microsoft is a U.S. registered trademark of Microsoft Corporation.
Windows and MS Windows are U.S. registered trademarks of Microsoft Corporation. 
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On-Screen Keyboard

Figure 4-1 On-Screen Keyboard

The on-screen keyboard is a graphical computer keyboard that enables you to touch or click (if using a mouse) the keys 
on a virtual keyboard. It functions like the external QWERTY keyboard, allowing you to enter text into any Windows or 
PXB application that accepts alphanumeric data. To launch the keyboard:

From Windows XP

• From the Windows task bar, click Start > All Programs > Accessories > Accessibility > On–Screen Keyboard. 

From Windows 7

• From the Windows task bar, click Start > All Programs > Accessories > Ease of Use > On-Screen Keyboard. 

From the PXB User Interface

• Select Tools > On-Screen Keyboard.

• Press the front panel Keyboard hardkey.

The front-panel Keyboard hardkey functions only when the PXB user interface is running.

User Installation of Software

Installation of Third Party Software

The PXB is an open Windows environment so you can install software on the instrument, however, the installation of 
third party software may affect instrument performance. Agilent Technologies does not warranty the performance of the 
PXB with any third party software installed.
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Capturing/Printing Displays and Windows 
NOTE Before installing any additional programs on the instrument, you should exit the PXB user interface.

Do not remove any factory installed applications or programs from the PXB.

Capturing/Printing Displays and Windows
This capture/print functionality is a Microsoft Windows XP capability. The following provides some guidelines for 
using this capability with the PXB. For more information, refer to the Microsoft Windows XP Help and Support 
documentation.

1. Capture the desired screen area:

• To capture the image of the entire desktop, press the Print Screen key on an external keyboard. This saves the 
image on the Windows clipboard.

• To capture the image of a single window, select the window and press the Alt + Print Screen keys on an 
external keyboard. This saves the image on the Windows clipboard. 

2. Open a graphics software program on the PXB.

Microsoft Paint is accessible on the PXB by selecting Start > All Programs > Accessories > Paint.

3. Press Ctrl + v keys to paste the clipboard contents into the graphics software. 

4. Save the image to a file.

If you save the file to a USB memory device, the saved graphic file can be easily transported from the PXB to a PC 
for use in other software applications.

5. From the graphics software, print the image.

Windows Security

Spyware Protection

There is no anti-spyware software installed on the PXB. To protect the instrument against security threats, pop-ups, and 
slow performance, it is recommended that you install anti-spyware software if you connect the PXB to the internet. If 
available, contact your IT department for assistance. 

System Backup
It is recommended that a regular backup strategy be implemented. Contact your IT department for information on any 
existing backup system which is suitable for the PXB and its data. 

Windows XP has a Backup utility that creates a copy of the information on your hard drive. In the event that the original 
data on your hard disk is accidentally erased or overwritten, or becomes inaccessible because of a hard disk malfunction, 
you can use the copy to restore your lost or damaged data. For more information on this utility, refer to the Microsoft 
Windows XP Help and Support documentation. 

A third party backup utility which is compatible with the PXB system software may be used. For more information, refer 
to “Installation of Third Party Software” on page 55.

When performing a backup, it is recommended that the data be sent to an external storage device connected to the 
network or one of the instrument’s USB connectors. 
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System Backup
NOTE If possible, schedule the backup at a time when the instrument is not being used for normal operations as it 
may impact the instrument's overall performance.
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System Backup 
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5 PXB Basic Configuration Setup

• One Channel Generate Configuration Setup on page 60

— 1. Basic Introduction and Turn On on page 60

— 2. Register External Instruments on page 61

— 3. Assign External Instruments on page 62

— 4. Assign Waveform Source and Load Configuration on page 64

— 5. Set Up and Download Waveform on page 64

— 6. Set Up Output I/O Port on page 65

— 7. Set Up Signal Generator on page 67

— 8. Play Waveform on page 68
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One Channel Generate Configuration Setup 
This example configuration setup will step you through the 1 Channel Generate configuration, the most basic of the PXB 
configurations. See the PXB online documentation for more information and examples.

Figure 5-1 Block Diagram

This configuration is completed by following these seven procedures:

1. Basic Introduction and Turn On

2. Register External Instruments

3. Assign External Instruments

4. Assign Waveform Source and Load Configuration

5. Set Up and Download Waveform

6. Set Up Output I/O Port

7. Set Up Signal Generator

8. Play Waveform

Use these steps to complete most of the PXB setups. Slight variations may occur to complete other configuration setups. 
Learn about each configuration type in the "Tutorials and Example Configuration Setups" section located in the PXB 
online documentation.

Step-by-step instructions for completing each of these basic steps are provided in the following sections.

1. Basic Introduction and Turn On

When the PXB is powered on, it displays a 1 Channel Generate configuration in the Configuration Browser as the 
default. This configuration is available to all PXBs. The PXB only displays configurations that the PXB supports. These 
supported configurations are determined by the number of baseband cards, I/O cards, and licenses installed in the PXB.

1. To turn on the PXB, press the front panel Power hardkey.

2. Allow the PXB to boot up and display the PXB user interface. 

3. Ensure that the 1 Channel Generate configuration is selected in the Configuration Browser. 

The block diagram for this selected configuration (shown in Figure 5-1) is displayed on the Block Diagram tab.

For additional information on the Configuration Browser, refer to the Configuration Basics tutorial section in the 
online documentation.
60 PXB Quick Start Guide



 PXB Basic Configuration Setup
One Channel Generate Configuration Setup
2. Register External Instruments

The PXB is designed to use a variety of external instruments to provide external inputs or receive the output of the PXB. 
These external instruments can be controlled by the PXB firmware; however, the external instruments must be registered 
within the firmware prior to being available for use.

This example will only require a signal generator (MXG or ESG). This process only needs to be performed once. If the 
instrument that you plan to use is already registered (see step 1), you may skip to the next section to assign your signal 
generator.

1. Click the External Instrument Table tab to display the External Instrument Table.

Figure 5-2 shows the External Instrument Table that has been populated with several external instruments used with 
the PXB.

The External Instrument Table displays the external instruments that are currently registered with the PXB 
firmware. External instruments that can be registered are:

• N5182A MXG Signal Generators (PXB output)

• N5172B EXG or N5182B MXG Signal Generators (PXB output)

• E4438C ESG Signal Generators (PXB output, PXB input and output for loopback configurations)

• N5102A Digital Signal Interface Module (DSIM) (PXB input or output)

• N9020A MXA Signal Analyzer (PXB input for external input configurations)

• E5515C/8960 Wireless Communication Test Set (PXB input and output)

The table displays the name, instrument type, address, and I/O Port of each registered external instrument. If no 
instruments are displayed in the table, then no instruments are currently registered.

Figure 5-2  External Instrument Table

2. Select the Add button to start the registration process. This displays the Register External Instrument dialog box. 
This procedure uses the N5182A MXG signal generator for example purposes.
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Figure 5-3  Default Register External Instrument dialog box 

3. In the Name text box, enter "MXG1" or another name to describe your signal generator. For the remainder of this 
example, the signal generator is referred to "MXG1". 

4. In the Family drop down list, select the instrument type that describes the instrument's family. In this case, select 
MXG.

5. In the Visa Interface drop down list, select the interface that the PXB will use to communicate with the instrument 
(TCPIP0 = LAN or GPIB0 = GPIB). 

6. In the Address text box, enter the LAN or GPIB address specific to the instrument that you are registering. 

7. Click OK to complete the registration. The External Instrument Table should now show the instrument that you 
just registered (an MXG, in this case). 

8. Click the Block Diagram tab to return to the configuration block diagram that was originally displayed. 

3. Assign External Instruments

With the 1 Channel Generate configuration selected, you now will assign the external instrument.

1. Review the block diagram. 

You will see a User File block, a BBG1 block and an I/O 1 Port A1 block (this block is an output which connects to 
a signal generator). You will also see an Unassigned block which represents an unassigned block for an external 
instrument (the signal generator).

Figure 5-4 Unassigned External Instrument

2. On the unassigned block, click the  button and then the Assign External Instrument tab to display the dialog 
box. 
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3. In the Assign area of the dialog box, select the MXG signal generator that you previously registered. 

Figure 5-5  Assign External Instrument

4. In the To area, leave the I/O Port Name field set to the default selection. Ensure that the I/O Port Type field is set 
to Digital. 

• The I/O Port Name field allows you to select any available I/O port.

• The I/O Port Type field allows you to select from two types of I/O port connections, digital or analog, for the 
ESG or MXG signal generators. For additional information, refer to the Assign External Instrument tutorial 
section in the online documentation.

5. Click OK to return to the block diagram. Note that the external instrument block now displays the selected signal 
generator. 

6. Connect the PXB to the signal generator as shown. 

For the rear panel connector locations, refer to Rear Panel on page 24.

Figure 5-6 PXG to MXG
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4. Assign Waveform Source and Load Configuration

Waveform (User File) blocks enable the user to select the signal creation source from an arbitrary waveform file (User 
File) or from a Signal Studio real-time option. In this example, we will select an arbitrary waveform file. 

1. The default waveform source selection is ARB (User File). If you have Signal Studio real-time options installed, you 

could click the  button to display the Assign Waveform Source dialog box and select a real-time format. 

2. Select the Load Configuration button to load the settings for each of the configuration blocks.

Selecting a tab label displays the tab's settings. The General Settings are similar to those found in a traditional signal 
generator such as; Waveform Source Name, Sample Rate, Trigger Delay, and Baseband Frequency Offset.

5. Set Up and Download Waveform

Once the configuration is loaded, the Settings Browser replaces the Configuration Browser in the left panel of the user 
interface. Each block from the block diagram is also listed in the Settings Browser. You are now able to view and edit 
the setting for each block. 

Set up the baseband generator block and download an example waveform to play. 

1. Open the waveform settings for User File1. This can be done in one of two ways: 

• Select the User File1 block in the block diagram

• Select the User File1 label in the Settings Browser 

2. Select Waveform Source Name to display the ellipsis button at the right edge of its settings cell. Select the 
ellipsis button to display the Open File dialog box. 

3. For this example, ensure the Default1.bin waveform is selected. This is the waveform that the baseband 
generator will play.

The Default1.bin waveform is 5000 samples, one cycle of a sine wave. It is a single tone that appears on the high 
side of the carrier with a frequency of (sample rate)/5000. For a sample rate of 100 MHz, the tone appears 20 kHz 
above the carrier frequency. 

The default folder, C:\Program Files\Agilent\PXB\FactoryDefaultWaveforms, contains the factory 
default waveforms. For additional information regarding waveforms, refer to Factory Default Waveform Files in the 
online documentation.

If you have already loaded other waveform files on the PXB, you can navigate to the folder it was saved in using the 
Open File dialog box.

4. In the Settings Browser or the block diagram, open the baseband generator settings for BBG 1. 

5. Notice the four tabs that are displayed: General Settings, Marker Generation, Power Calibration Settings, and 
Power Calibration Graphics.
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Figure 5-7  Baseband Generator BB Gen1

Selecting a tab label displays the tab's settings. The General Settings are similar to those found in a traditional signal 
generator such as; Waveform Source Name, Sample Rate, Trigger Delay, and Baseband Frequency Offset.

6. Select the Marker Generation tab to review this tab's settings. 

7. Select the Power Calibration Settings tab to review this tab's settings. The Power Calibration Graphics tab 
provides a graphical description of some of the power control settings. 

8. Select Block Diagram to return to the block diagram. 

9. Select Load Waveforms (see Figure 5-8 on page 66) to display the Waveform Table.

The table displays the selected waveform source file as Waveform 1. Notice that Waveform Status is 
”Out-of-Date” and Download Status is ”Not Started,” which indicates that the waveform has not been loaded to the 
baseband generator yet.

10. Select Start to download the designated waveform from the PXB hard drive to the playback memory of the 
baseband generator. 

Notice that, once the waveform has been downloaded, Waveform Status is displayed as "Up–to–Date" and 
Download Status is displayed as "Completed".

11. Return to the block diagram. 

6. Set Up Output I/O Port

The output I/O port is used as the output interface to an external instrument (either a signal generator or an N5102A 
Digital Signal Interface Module) at the output of the PXB. The output I/O block has its own settings that are customized 
for the output. For additional information, refer to the I/O Port Setup tutorial in the online documentation. 

1. Open the I/O Port settings for I/O1 Port A1. This can be done in one of two ways: 

• Select the I/O1 Port A1 block in the block diagram

• Select the I/O1 Port A1 label in the Settings Browser 

2. Notice the four tabs that are displayed: General Settings, AWGN Settings, Marker Selection, and AWGN 
Graphics. 
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Figure 5-8  I/O 1 Port A1 (Output)

The following is a quick review of how each of the tabs can influence the output of the PXB.

3. Review the General Settings tab. 

The General Settings tab provides information about the I/O port and can be used to make changes to the I/O port. 
You will notice that the Mode setting is a read-only entry that displays Output indicating that this I/O port is being 
used as an output I/O.

4. Select the AWGN Settings tab to review this tab's settings. This tab is used to add and control Additive White 
Gaussian Noise (AWGN) to the output signal at the I/O port. The AWGN Graphics tab provides a graphical 
description of some of the AWGN settings. 

5. Select the Marker Settings tab to review this tab's settings. For additional information, refer to the Marker Basics 
tutorial in the online documentation.

The I/O output block can pass the existing markers from the input source, the baseband generator or I/O input block, 
or can dynamically generate new markers based on the waveform present at the I/O output block. Markers that are 
generated from an output I/O block that is receiving a single-input waveform are merged with the waveform as it 
was received. Therefore, if the original waveform has had fading or interference added, the degraded waveform is 
used to generate these markers. This is important to note because dynamic markers use the values of the waveform 
samples to determine when markers are generated.

Any output I/O markers are used instead of the markers previously embedded in the original waveform file or those 
generated by a user-created marker file or baseband generator block.

6. Return to the block diagram.
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7. Set Up Signal Generator

The PXB provides direct control of several of the signal generator settings. These settings include the output frequency, 
the output amplitude, and the internal marker routing and more. It does not provide control of all the signal generator 
settings.

1. Open the MXG settings for MXG1, the signal generator that we have assigned as the external instrument for this 
configuration. This can be done in one of two ways. 

• Select the MXG1 block in the block diagram

• Select the MXG1 label in the Settings Browser 

2. Notice that this external instrument has two tabs that are displayed: General Settings and Marker Routing.

Figure 5-9  Signal Generator (MXG) MXG1

3. Select the Preset button to preset the signal generator.

4. Review the General Settings tab. 

The General Settings tab is comprised of three categories.

• Basic Settings which provides control of basic signal generator settings

• ALC Settings which provides control of the signal generator's Automatic Level Control (ALC) and attenuator 
circuitry

• Power Search Settings which provides control of the signal generator's power search function when a power 
calibration is performed

5. Set the RF Output parameter to On so the signal generator’s RF Output connector will be on when the waveform is 
played. 

6. Set the ALC parameter to Off so the signal generator’s ALC circuitry will not interfere with the power calibration 
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when it is performed.

7. Select the Marker Routing tab to review this tab's settings. This tab allows you to set up the markers to control the 
Pulse/RF Blanking and the ALC Hold features. The PXB will overwrite these settings based on the system 
configuration as necessary to provide accurate output power to the signal generator.

8. Return to the block diagram.

8. Play Waveform

Once the PXB configuration is set you can calibrate the system power and play the waveform from the BBG 1 block 
through the I/O block to the connected signal generator through the digital bus.

Figure 5-10Calibrate Power

1. Power calibration occurs automatically by default. If you want manual control of power calibration, select Manual 
in the System > Calibration > Power Calibration menu, then select the Calibrate Power button to perform the 
power calibration based on the baseband generator block's Power Control Settings and the output I/O block's AWGN 
Settings.

Note: You cannot perform a Calibrate Power operation unless the selected waveform in the Download Panel has 
both "Up-to-Date" and "Completed" waveform status.

2. Select the Play button to start playing the waveform from BBG 1. 

3. When you wish to stop playing the waveform, select Stop. 

To save the configuration and its settings, select File > Save. 

To recall the configuration and its settings, select File > Recall. 
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6 Safety and Regulatory Information

• Warnings, Cautions, and Notes on page 70

• General Safety Considerations on page 70

• Lifting and Transporting on page 70

• Instrument Markings on page 71

• Toxic or Hazardous Substance and Elements Table on page 72

• Regulatory Information on page 72

• Prior to contacting Agilent Technologies be prepared with the PXB's model number and full serial number. This 
information is provided to the Agilent Technologies representative in order to determine the instrument's warranty 
period. on page 73
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Warnings, Cautions, and Notes
The documentation for this product uses the following safety notations. Familiarize yourself with each notation and its 
meaning before operating the PXB.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if not correctly performed or 
adhered to, could result in personal injury or loss of life. Do not proceed beyond a warning note 
until the indicated conditions are fully understood and met.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not correctly performed or adhered to, 
could result in damage to or destruction of the PXB; or in the loss of a user’s settings or data. Do not 
proceed beyond a caution note until the indicated conditions are fully understood and met.

NOTE Note calls the user’s attention to an important point or special information in the text. 

General Safety Considerations

WARNING If the PXB is not used as specified, the protection provided by the equipment could be impaired. 
The PXB must be used in a normal condition only, in which all means for protection are intact.

WARNING Personal injury may result if the PXB covers are removed. There are no operator serviceable parts 
inside. To avoid electrical shock, refer servicing to qualified personnel.

Lifting and Transporting 
The weight of the PXB can exceed 33 kg (70 lbs). The PXB should be lifted by at least two people. If two people are not 
available, use a mechanical lift to lift the PXB. The PXB should be transported using a rolling cart.

Weight and Dimensions

Weight: 33 kg (70 lbs.)

Dimensions (Height X Width X Depth): 

• Centimeters: 21.9 cm X 42.5 cm X 59.1 cm

• Inches: 8 5/8” H X 16 3/4” W X 23 1/4” D
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Instrument Markings
The PXB has the following markings. Familiarize yourself with each marking and its meaning before operating the 
PXB.

The instruction manual symbol. The product is marked with this symbol when it is necessary for 
you to refer to instructions in the manual.

The CE mark is a registered trademark of the European Community. If this symbol is accompanied 
by a year, it is the year when the design was proven.

The CSA mark is a registered trademark of the Canadian Standards Association International.

The C–Tick Mark is a trademark registered to the Australian Spectrum Management Agency. This 
indicates compliance with all Australian EMC regulatory information.

This is the symbol of an Industrial Scientific and Medical Group 1 Class A Product. (CISPER 11, 
Clause 4)

This symbol marks the on position of the power line switch.

This symbol marks the standby position of the power line switch.

This symbol indicates that the input power required is AC.

ICES/NMB–001 This is a marking to indicate product compliance with the Canadian Interference–Causing 
Equipment Standard (ICES–001)

This product complies with the WEEE Directive (2002/96/EC) marking requirements. The affixed 
label indicates that you must not discard this electrical/electronic product in domestic household 
waste.

Product Category: With reference to the equipment types in the WEEE Directive Annex 1, this 
product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Agilent Technologies office.

EFUP (Environment–Friendly Use Period) indicates the time period during which no hazardous or 
toxic substances or elements are expected to leak or deteriorate during normal use and generally 
reflects the expected useful life of the product. The time period is stated in terms of the number of 
years, starting with the date of manufacture. 
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Toxic or Hazardous Substance and Elements Table
Toxic or Hazardous Substance and Elements Table
The PXB may contain replaceable assemblies or components (including the disk drive, power supply, mouse, display, or 
battery, which are not manufactured by Agilent Technologies) which have a shorter EFUP (Environment–Friendly Use 
Period) number than that which is indicated on the product itself (40 is indicated for the PXB). In cases where the 
assembly, component, or part is labeled with an EFUP which differs from the one indicated by Agilent Technologies, the 
EFUP on the assembly, component, or part takes precedence. Agilent Technologies makes no claims concerning, and 
takes no responsibility for the EFUP numbers reflected on goods which are not manufactured by Agilent Technologies. 

Document part number 9320–6691 is the Toxic or Hazardous Substances and Elements Table and is shipped with each 
PXB.

Regulatory Information
EMC: Complies with the essential requirements of the European EMC Directive as well as current editions of the 
following standards (dates and editions are cited in the Declaration of Conformity):

• IEC/EN 61326-1

• CISPR Pub 11  Group 1, class A

• AS/NZS CISPR 11

• ICES/NMB-001

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

South Korean Class A EMC declaration: This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

SAFETY: Complies with the essential requirements of the European Low Voltage Directive as well as current editions of 
the following standards (dates and editions are cited in the Declaration of Conformity):

• IEC/EN 61010-1

• Canada: CSA C22.2 No. 61010-1

• USA: UL std no. 61010-1

This product complies with the China standard GB18455–2001 packaging marking requirements. 
The ISO standard recycling symbol marking is used on all primary and secondary fibreboard 
packaging covered by China RoHS.

This equipment is Class A suitable for professional use and is for use in electromagnetic 
environments outside of the home.
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Regulatory Information
Acoustic statement: (European Machinery Directive)

Acoustic noise emission 

LpA <70 dB

Operator position

Normal operation mode per ISO 7779 

To find a current Declaration of Conformity for a specific Keysight product, go to: 
http://www.keysight.com/go/conformity

Certification

Agilent Technologies certifies that this product met its published specifications at the time of shipment from the factory. 
Agilent Technologies further certifies that its calibration measurements are traceable to the United States National 
Institute of Standards and Technology, to the extent allowed by the Institute’s calibration facility, and to the calibration 
facilities of other International Standards Organization members.

Assistance

Product maintenance agreements and other customer assistance agreements are available for Agilent Technologies 
products. For assistance, contact Agilent Technologies.

NOTE Prior to contacting Agilent Technologies be prepared with the PXB's model number and full serial number. 
This information is provided to the Agilent Technologies representative in order to determine the instrument's 
warranty period.
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Numerics
1 Channel Generate configuration, 60
10 MHz Out connector, 25
10 MHz reference, 30
100 MHz Sys Clk Out connector, 25
18, 24

A
AC

power cord, connecting, 7
power receptacle, 25
symbol, 71

accessories, 3
accounts, administering user, 34–37

account setup, 34
adding new accounts, 35
changing accounts, 36
existing accounts, 34
password setup, 34

active window, capture, 56
Agilent Recovery System Procedure, 51
ALC settings, 32
alcohol, cleaning with, 16
altitude requirements, 7
analog output

I- Q- connectors, 28
I+ Q+ connectors, 28

anti-spyware software, 56
anti-virus software, 13
assistance, customer agreements, 73
Australian Communications Authority, 71
Aux I/O connector, 25

B
baseband generator setup, 64

C
cable

digital bus, 3
external reference, 3
trigger, 3

cables, 30
calibration, power, 32
Canadian

Interference-Causing Equipment Standard, 71
Standards Association (CSA) mark, 71

capture active window, 56
capturing screens, 56
cautions, 70
CE, European Community trademark, 71
certification, 73
checking the shipment, 2
cleaning

connectors, 17
instrument cover, 17
touch screen display, 16

clock in connector, 27
clock out connector, 27
computer name, determining the, 43
configuration setup, 1 channel generate

baseband generator setup & waveform download, 64
external instrument assignment and setup, 62
external instrument registration, 61
output I/O setup, 65
signal generator setup, 67
turn on and basic introduction, 60
waveform playback, 68

connecting
keyboard, 9
monitor, 9
mouse, 8

connectors
cleaning, 17
rear panel, 24–28
USB, 23, 26

contents, 2
CPU host controller connectors, 26

eSATA connector, 26
GPIB connector, 26
interconnect 1/2 connector, 26
LAN connector, 26
monitor connector, 26
PCIe x4 From Upstream connector, 26
PCIe x4 To Downstream connector, 26
USB master connector, 26
USB slave connector, 26

C-tick mark, 71
customer assistance agreements, 73

D
data security, 52
data sheet, 3
desktop operation, remote, 44
digital bus

cable, 3
I/O connector, 28

digital I/O bus, 30
dimensions, 70
display, cleaning the touch screen, 16
display, touch screen, 22, 33
documentation, 17

list of, vii
ordering, 3

E
E4438C ESG signal generator firmware requirements, 9
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electrical requirements, 7
environmental requirements, 7
Environment-Friendly Use Period (EFUP), 72
equipment rack installation, 8
error messages documentation, vii
errors, unexpected PXB, 31
eSATA connector, 26
ESG

ALC settings, 32
as an RF output device, 32
firmware requirements, 9, 30

European Community trademark, 71
Ext

I/O Clk In connector, 24
Ref Out connector, 25
Sync connector, 24
Trig In connector, 24

external instrument, 32
assignment, 62
connection diagrams, 10
connections, 9
firmware requirements, 9, 30
registration, 61

external reference cable, 3

F
fader, 33
firewalls, 13
firmware, 31

licenses, 15
option, licensing, 38
requirements for external instruments, 9, 30
upgrade guide, vii

frequency requirements, 7
front handles, 3
front panel, 20–23

hardkeys
0-9, 21
Alt (Alternate), 21
Bk Sp (Backspace), 21
Cancel (Esc), 21
Ctrl (Control), 21
Decimal Point, 21
Delete, 21
Enter, 21
Help, 22
Keyboard, 22
Left/Right Arrows, 21
Main, 21
Minus Sign, 21
Numeric Keypad, 21
Power On/Off, 22
Preset, 22

RPG, 22
Space, 21
System, 22
Tab (Left), 22
Tab (Right), 22
Touch On/Off, 22
Up/Down Arrows, 21

touch screen display, 22
USB connectors, 23

G
GPIB, 31
GPIB connector, 26

H
handles, 3
hazardous substance and elements table, 72
Help documentation, 17
hostname, determining the, 43
humidity requirements, 7

I
I- Q- analog outputs, 28
I/O board connectors, 27–28

clock in, 27
clock out, 27
digital bus I/O, 28
I- Q- analog outputs, 28
I+ Q+ analog outputs, 28
mkr out, 27
trg in, 27

I/O Clk Out connector, 25
I+ Q+ analog outputs, 28
ICES symbol, 71
image recovery, restoring to factory default, 51
inspection, shipping container, 2
installation in an equipment rack, 8
instrument

dimensions, 70
power option, 13
weight, 2, 70

intellectual property security, 52
interconnect 1/2 connector, 26
interconnections, external equipment, 9
IP address, checking the, 43
ISM1-A symbol, 71

K
keyboard

connecting a, 9
on screen, 55
remote desktop shortcuts, 50

keys to success with the PXB, 30–33
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10 MHz reference, 30
cables, 30
digital I/O bus, 30
external instrument firmware, 30
external instruments, 32
fader, 33
LAN and GPIB, 31
MIMO configurations, 33
MXA as RF input device, 32
MXG/ESG ALC settings, 32
MXG/ESG as RF output device, 32
play, 33
power, 30
power calibration, 32
PXB firmware, 31
PXB licensing, 31
PXB unexpected errors, 31
touch screen, 33

keys, front panel, 20–22
knob, 22

L
LAN, 31

connections, 15
connector, 26

licensed firmware options, 38
licensing, 15, 31
lifting the PXB, 70
line setting requirements, 7

M
maintenance agreements, 73
manuals, ordering, 3
Marker Out connector, 25
MIMO configurations, 33
mkr out connector, 27
monitor connector, 26
monitor,connecting a, 9
mouse, connecting a, 8
MXA, 32

firmware requirements, 9, 30
MXG

ALC settings, 32
as RF output device, 32
firmware requirements, 9, 30

N
N5182A MXG signal generator firmware requirements, 9
N9020A MXA signal analyzer firmware requirements, 9

O
on screen keyboard, 55
online documentation, 17

options
baseband hardware, 4
built-in firmware, 4
hardware/firmware bundle, 4
I/O hardware, 4
licensed firmware, 38
PXB, 4
software bundle, 4
upgrade, 4

output I/O setup, 65

P
pass/fail testing, self test, 39
password setup, 34
PCIe x4 From Upstream connector, 24, 26
PCIe x4 To Downstream connector, 26
playing the waveform, 33
power, 30

calibration, 32
connecting, 7
cord, removing the, 14
disconnecting, 7
line cord, 7
on, initial, 12
option settings, 13
receptacle, 25
requirements, 7
symbol, 71
turning off the PXB, 14

power-up self test, 13
protection, spyware, 56
PXB

firmware, 31
licensing, 31
to external equipment interconnections, 9
unexpected errors, 31

R
rack mount kit, 3
rack, installation in an equipment, 8
rear panel connectors, 24–28

AC power receptacle, 25
CPU host controller

eSATA, 26
GPIB, 26
interconnect 1/2, 26
LAN, 26
monitor, 26
PCIe x4 From Upstream, 26
PCIe x4 To Downstream, 26
USB master, 26
USB slave, 26

I/O board
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clock in, 27
clock out, 27
digital bus I/O, 28
I- Q- analog outputs, 28
I+ Q+ analog outputs, 28
mkr out, 27
trg in, 27

System Clock
10 MHz Out, 25
100 MHz Sys Clk Out, 25
Aux I/O, 25
Ext I/O Clk In, 24
Ext Ref Out, 25
Ext Sync, 24
Ext Trig In, 24
I/O Clk Out, 25
Marker Out, 25

recovery procedure, 51
regulatory information, 69
remote desktop

keyboard shortcuts, 50
overview, 44
running a remote desktop session, 46
setting options, 47
setup, 44

remove sensitive data, 52
removing power cord, 14
requirements, electrical and environmental, 7
returning the PXB, 52
RF input, 32
RF output device, 32

S
safety considerations, 70
safety information, 69
screen, capturing a, 56
screen, touch, 22, 33
security features documentation, vii, 52
security, data, 52
security, Windows, 56
self test, power-up, 13
sensitive data, removing, 52
setup

ESG to PXB, 10
external instrument, 9
MXA to PXB to ESG, 10
MXG to PXB, 10
PXB to Digital Signal Interface Module, 11
PXB to ESG Analog I/Q, 11

shipping container, inspection, 2
shipping requirements, 52
shut down

power off, 14

using the Power hardkey, 14
with mouse, 14

signal analyzer firmware, 9
signal generator firmware, 9
signal generator setup, 67
software

anti-virus, 13
customer installed, 55
third party, 55

spyware protection, 56
standby symbol, 71
system backup, 56
system clock rear panel connectors, 24–25

10 MHz Out connector, 25
100 MHz Sys Clk Out connector, 25
AC power receptacle, 25
Aux I/O connector, 25
Ext I/O Clk In connector, 24
Ext Ref Out connector, 25
Ext Sync connector, 24
Ext Trig In connector, 24
I/O Clk Out connector, 25
Marker Out connector, 25

system recovery procedure, 51

T
temperature requirements, 7
test, self, 39
touch screen display, 22, 33

cleaning the, 16
toxic or hazardous substance and elements table, 72
transporting the PXB, 70
trg in connector, 27
trigger input cable, 3
turn off PXB, 14
turn on, 1 channel generate configuration, 60

U
unexpected errors, 31
unpacking, 2
unplug, 14
USB connectors, 23, 26
user accounts, administering, 34–37

account setup, 34
adding new accounts, 35
changing accounts, 36
existing accounts, 34
password setup, 34

V
ventilation requirements, 7
virus protection, 13
voltage requirements, 7
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W
warnings, 70
waveform download, 64
waveform playback, 68
weight, 2, 70
Windows security, 56

X
XP considerations, 54
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